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WireXpert Copper Cable Certifier Series
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Element Description  Element Description  Element Description
1 Hanging Cleat 7 AUTOTEST 13 FlipTag
2 Camera 8 Kickstand 14-17 USB-Port 1-4
3 Flashlight 9 Speaker 18 Mainframe
4 Micro-USB 10 Power Button Comm. Port
Port

5 Audio Port 11 LCD 19 Test Module

Touchscreen Comm.Port
6 Charging Port 12 Home button

For more detailed information on how to use and specification of
the product, please scan QR code to read the User Manual for
more information.

https://itnetworks.softing.com/WireXpert-MP

This product shall only be used within the conditions listed in the main
manual and datasheet.
Please refer to the user manual and datasheet for more information.

CAUTION

Do not connect device to a voltage source such as an active telephone jack.
Excessive voltage will damage the units and the adapter and void the
warranty.

© Softing Singapore Pte. Ltd. In line with our policy of continuous improvement and
feature enhancement, product specifications are subject to change without notice. All
rights reserved. Softing and the Softing Logo are trademarks or registered trademarks of
Softing AG. All other trademarks, registered or unregistered, are sole property of their
respective owner.

For more information, please refer to https://itnetworks.softing.com/

Version 1.9.5
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Home screen

Slide-down menu Project, Site & Data

The Slide-down menu can be triggered by performing a swipe-down action from the
top of the screen w. It provides quick accessible options to user and device
configurations. Slide the menu upwards or press the [Home] button to hide menu.

The Status bar displays the current date & time, Wi-Fi connectivity status , USB
connectivity status , device connectivity status and battery level . Tap icons to change
or view setting.

Copper Connection Status - Reports instantaneous wiremap reading when a LOCAL and
REMOTE unit are connected.

Project, Site & Data - Project oriented configurations and information, such as site
information and test results.

Test Settings - Test oriented configurations, such as cable and connector selection, test
limits and options.

Tools - Advanced and single test applications.

Configuring Device
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Test Limit
PROJECT(1) SITE(1)
TIA - Cat 6A Channel »
Q + aQ +
Cable & Connector
Cable: CAT 6A UTP >
Manufacturer: Generic UTP
NVP: 68.0 >
Connector:  UTP Mode Jack 6A >

Manufacturer: Generic Unshielded

Test Options
Locator
Cable Pairing Type T568-B >

Autotest On Connection

Project > Add Project

Site > Add Site Test Settings

Swipe downwards from the top of the screen to bring down the slide-down menu.
a. Under User Portal, login using the designated credentials.

From the Home screen, select [Project, Site & Data]

Select [Project]

a. Select or create a new Project

b. Tap [Back] to return to the previous screen

Select [Site]

a. Select or create a new Site

b. Select [Label Source]

Press the [Home] f button to return to the Home screen

Select [Test Settings]

a. Select [Test Limits]

b. Select [Cable]. Select Generic Unshielded/Shielded if unsure of Manufacturer.

c. Select [Connector]. Select Generic Unshielded/Shielded if unsure of Manufacturer.

Press the [Home] @ button and select [Set Reference||_25|.

Additional Configuration
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Test Options 1

Auto Save

Advanced Options

Test Options
Locator — If enabled, device will display NEXT and Return Loss
| (RL) fault information in an AUTOTEST result.
2. Cable Pairing Type - Choose T568A or T568B copper cable
wiring standard.
3. Allow Mixed Adapters Mode - Refer to User Manual for
more information.
4. AC Wiremap - If enabled, device is able to measure test runs
with Power over Ethernet (PoE) midspan devices in between.
The device supports cable runs with IEEE 802.3 af and 802.3

Pairing Type T568-B »

Mix Adapters Mode

AC Wiremap

Crossover

Shield Integrity

N rai

Test Sei‘tings > Test
Options

Ignore Wiremap

at injectors.

Crossover - Refer to User Manual for more information.

DCRU - If enabled, device will perform additional DC

resistance unbalance test measurements between pairs

and within each pair in accordance with TIA and IEC
specifications, on top of the AUTOTEST parameters
required in a Channel or Permanent Link test. Refer to User

Manual for more information.

7. Shield Integrity - If enabled, device will perform integrity test
to identify if a shield is present and connected between both
ends on the actual cable under test.

8. TCL- If enabled, device will perform additional TCL/ELTCL test
measurements during the Autotest. Depending on the
selected limit, electromagnetic exposure zones E1, E2, and E3
as described in ISO/IEC 11801-3 and TIA-1005A can be
selected. Refer to User Manual for more information.

9. Auto Save - If enabled, test results will be automatically
saved after each Autotest. Only a PASS result will be saved.
Option will be disabled if current Label Source is List Based
Testing. Refer to List Based Testing for more information.

nal Dace /Eail 5.

Advanced Options

1. lIgnore Wiremap - If enabled, device will ignore wiremap test
result and proceed with other measurement tests. Disabled
by default.

2. Marginal Pass/Fail - If enabled, device will display marginal
pass (PASS*) and marginal fail (FAIL*) results. A marginal test
result is obtained when its margin is smaller than the
accuracy specification for the test parameter. Enabled by
default.

3. Single Ended Test - If enabled, device will be able to perform
test using only a LOCAL unit. Depending on requirement, a
far-end termination plug may be required. Custom limited
must be selected. Disabled by default.


https://itnetworks.softing.com/WireXpert-MP
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Setting Reference

It is necessary to perform a set reference measurement if the LOCAL and REMOTE units are
being paired for the first time. If there is a mismatch in firmware versions or a set reference
has not been performed, Autotest will be denied, until these conditions are corrected.
Please also ensurethat the calibration dates of the devices have not expired.

Permanent Link Channel
Test Adapter Test Adapter

Permanent Link/
Test Reference Cord

To set reference,
1. Ensure that the Copper Test Modules are properly attached to the Mainframes of the
LOCAL and REMOTE units.
Connect a Permanent Link adapter to the LOCAL unit.
Connect a Channel adapter to the REMOTE unit.
Connect the 2 units together using the reference cord provided in the kit.
From the Home screen, select [Tools] = Set Reference
Ensure that the 2 units are connected . Tap [Next] to continue.
Enable [DCRU Calibration] to perform the additional step of performing calibration of
the DCRU measurements. This step is optional and will not affect the accuracy of the
Set Reference if disabled. If enabled,

NouekwnN

Steps 7b and 7k Steps 7e and 7h

a. Respective instructions will be prompted on the LOCAL and REMOTE units after Set

Reference is completed.
On the LOCAL unit,

b. Disconnect the reference cable from the REMOTE unit and connect it to the DCRU
Calibration Artifact.

c. Tap [Next] to continue.

d. Swap the Permanent Link Test Adapter with the other Channel Test Adapter.

e. Disconnect the DCRU Calibration Artifact from the cable and connect it to the Test
Adapter.

f. Tap [Next] to continue.

g. Disconnect the DCRU Calibration Artifact.

On the REMOTE unit,

h. Connect the DCRU Calibration Artifact to the Channel Test Adapter.

i. Tap [Next] to continue.

j. Swap the Channel Test Adapter with the other Permanent Link Test Adapter.

k. Connect the TERA end of the reference cord to the Test Adapter and the other end
to the DCRU Calibration Artifact.

I. Tap [Next] to continue.

m. Set Reference and DCRU calibration is now completed.

Set Reference will fail in the event of-
e Test adapters mismatch, i.e., two channel or permanent link adapters.
e Firmware version mismatch between LOCAL and REMOTE units.

e No connection between LOCAL and REMOTE units.

Performing an Autotest

Permanent Link test is comprised of the connection from a patch panel to a
telecommunication outlet (horizontal cabling) using Permanent Link test adapters at each
end of the link under test.

Permanent Link Test

Horizontal Cabling
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PERMANENT LINK

Permanent Link/
Test Reference Cord

1. Attach the Permanent Link Test Adapters into the LOCAL and REMOTE units of the
device.

2. Set reference is required if the devices are being paired for the first time or has not

been used for an extended period.

From the [Home] screen, select [Test Settings] =2 [Test Limits]

Choose the Limit Standard and select the Permanent Link limits.

Configure other settings if necessary.

Connect the one end of the unit to the patch panel and the other unit to the outlet

using the Permanent Link/Reference cords provided.

7. Press the AUTOTEST button to begin AUTOTEST.
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Channel test is comprised of the connection from an active device (eg. Router) in a data
rack, a telecommunication outlet (horizontal cabling) and the connecting patch cords at
both ends using Channel test adapters at each end of the link under test. The
recommended length for the patch cord from the patch panel and the outlet is 5m.

Channel Test

TINNVHD
‘CHANNEL

1.

Attach the Channel Test Adapters into the LOCAL and REMOTE units of the device.

Set reference is required if the devices are being paired for the first time or has not
been used for an extended period.

From the [Home] screen, select [Test Settings] = [Test Limits]

Choose the Limit Standard and select the Channel limits.

Configure other settings if necessary.

Connect the one end of the unit to the patch panel and the other unit to the outlet
using the patch-cords that will be used to connect the active devices.

7. Press the AUTOTEST button to begin AUTOTEST.
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Test summary screen indicating the overall test result and individual parameters with the
following symbols. More information can be viewed by selecting the parameter on the test
result screen.

« “PASS” — Good test result in “FAIL” — Unacceptable results with
accordance to pre-defined settings. severe disturbance on one or more
test parameters.

Marginal “PASS” — “PASS” result @ Marginal “FAIL” — “FAIL” result with

with one or more test parameters one or more test parameters that
that have margin in the range of have negative margin in the range
uncertainty of the tester. of uncertainty of the tester.

Q

For Information Only - Parameter is
tested but not required for the
selected test limit or configuration.




@)
SOftﬂm@ WireXpert Quick Reference Guide

Managing Results

Test results can be manually saved by selecting [Save] after an Autotest or single
application test in Tools is completed. When prompted, enter label name and tap the

[Save] button to save.
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Demo-001
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Autotest result screen

2123 | British English

Enter label

Result saved

Test results will be named in alpha-numeric sequence depending on the selected Label
Source when Autotest is completed.
PASS results will automatically be saved if the Auto Save option is enabled. FAILED results

can only be saved manually.
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Demo Proejct

Project 2024-09-04 04:50:45

Demo Site 02
Site 2024-09-04 06:46:15

Demo Site 03
Site 2024-09-04 06:46:15

Demo Site 01
Site 2024-09-04 06:49:23

Demo Project
Project 2024-09-04 06:54:14

Demo Project 02
Project 2024-09-04 06:56:24

Sample Project

Project 2024-09-04 06:56:24

Demo Project 02
Project 2024-09-04 08:39:05

Sample Project 03
Project 2024-09-04 08:50:41

Demo Site 01
Site 2024-09-04 09:24:42

Sample Site 03

Trash

To view saved results, press the [Home] button and select [Project, Site & Data] -> [Datal]

Saved results can be renamed or deleted from the Data screen.

To retrieve deleted results, press the [Home] button and select [Tools] -> [Trash]
Files deleted from [Trash] will be permanently deleted and not recoverable.

To transfer results to the PC software, please refer to the User Manual for more

information.
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